Puma III Series
User Manual

http://www.GCCworld.com

V.14 2014 Mar.
NOTICE

GCC reserves the right to modify the information contained in this user manual at any time without prior notice; un-authorized modification, copying distribution or display is prohibited. All comments, queries or suggestions concerning this manual please consult with your local dealer.
Important Information

Thanks for your purchase of GCC Puma III Cutting Plotter. For your safety and to optimize the performance of the Puma III, please read the user manual completely and keep it in a correct location.

PRECAUTIONS IN USE

- For safety concern, please always hold the cutter firmly from the bottom when moving it. Do not move the cutter by clasping the depression area on both sides.

- Do not shake or drop the blade holder, a blade tip maybe fly out.
- During operation, keep away from any moving parts of the cutter (such as the carriage, drums). Also be careful that your clothing and hairs do not be caught.
- Always connect the power cable to a grounded outlet.
- Always use the accessory power cable that is provided. Do not wire the power cable so that it becomes bent or caught between objects.
- Do not connect the power cable to branching outlet to which other machines are also connected, or use an extension cable. There is danger of overheating and of misoperation of the machine.
- Keep the tools away from children where they can reach.
- Always put the pinch rollers within position of the white marks.
## Contents

### Important Information

### 1. General Information
- **1.1 Introduction** 1-1
- **1.2 Package Items** 1-1
- **1.3 Product Features** 1-2
- **1.4 Appearance of Puma III** 1-3
  - **1.4.1 The Front View** 1-3
  - **1.4.2 The Back View** 1-4
  - **1.4.3 The Whole View** 1-5
  - **1.4.4 The Left-hand Side** 1-6
  - **1.4.5 The Right-hand Side** 1-6

### 2. Installation
- **2.1 Precaution** 2-1
- **2.2 Stand & Flexible Media Support System** 2-2
  - **2.2.1 Stand Installation (for P3-60)** 2-2
  - **2.2.2 Stand & Flexible Media Support System (for P3-132S)** 2-3
- **2.3 Desktop Support Brackets** 2-6
- **2.4 Blade Installation** 2-8
- **2.5 Cable Connections** 2-12
  - **2.5.1 USB Interface** 2-12
  - **2.5.2 Driver Un-installation** 2-15
  - **2.5.3 RS-232 Interface** 2-18
  - **2.5.4 Data Transmitting** 2-19
  - **2.5.5 Printer Server Shared Setting** 2-19

### 3. The Control Panel
- **3.1 The LCD Panel** 3-1
- **3.2 Menu in On-line Mode** 3-2
- **3.3 Menu in Off-line Mode** 3-3
- **3.4 Menu Items** 3-5

### 4. Operation
- **4.1 Media Loading** 4-1
  - **4.1.1 Loading the Sheet Media** 4-1
  - **4.1.2 Loading the Roll Media** 4-3
- **4.2 Tracking Performance** 4-6
- **4.3 Cutting Force and Offset Adjustment** 4-6
- **4.4 When Completing the Cutting Job** 4-8
- **4.5 Puma III Print Driver setting** 4-9
  - **4.5.1 Puma III Print Driver setting>Option Page** 4-9
- **4.6 Reference Parameter setting for different materials** 4-12

### 5. Automatic-Aligning System
- **5.1 Introduction** 5-1
- **5.2 Calibrating the System** 5-2
  - **5.2.1 Media Calibration** 5-2
5.2.2 AAS Calibration 5-2
5.2.3 AAS II on Puma III 5-3
5.3 Printer Test 5-4
5.4 Registration Mark Offset Range 5-6
5.5 Contour Cutting 5-6
5.6 Tips for AAS 5-8

6. Maintenance
6.1 Cleaning the cutting Plotter 6-1
6.2 Cleaning the Grid Drum 6-2
6.3 Cleaning the Pinch Rollers 6-2

7. Trouble Shooting
7.1 Non-Operational Problems 7-1
7.2 Operational Problems 7-2
7.3 Communication Problems 7-3
7.4 Software Problems 7-4
7.5 Cutting Quality Problems 7-5

Appendix
A-1 Specifications of Puma III A-1
A-3 CorelDRAW Plug-In Instruction A-3
A-4 SignPal 10.5 Instruction A-4
A-5 EasySIGN Instruction A-5
A-6 GreatCut Instruction A-6
A-7 Illustrator Plug-In Instruction A-7
A-8 DirectCut A-8
Chapter 1 General Information

1.1 Introduction
Puma III series cutting plotters have been designed to produce computer-generated images or perform contour cutting on sheets or rolls of vinyl media.

This manual covers the following models of Puma III series cutting plotters:

<table>
<thead>
<tr>
<th>Model</th>
<th>Media Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>P-3-60</td>
<td>70mm(2.76&quot;) ~ 719mm(28.3&quot;)</td>
</tr>
<tr>
<td>P-3-132S</td>
<td>70mm(2.76&quot;) ~ 1470mm(57.87&quot;)</td>
</tr>
</tbody>
</table>

1.2 Package Items
The package of the Puma III model contents the items listed below, please check carefully.
If you find any item missing, please consult your local dealer for further assistance.

<table>
<thead>
<tr>
<th>Standard Item</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Cutting Plotter</td>
<td>1</td>
</tr>
<tr>
<td>2. Stand Set (for P-3-132S only, optional for P-3-60)</td>
<td></td>
</tr>
<tr>
<td>● 2 piece of T-shape stand</td>
<td></td>
</tr>
<tr>
<td>● 1 piece of stand beam</td>
<td></td>
</tr>
<tr>
<td>● 20 pieces of M6 screws</td>
<td></td>
</tr>
<tr>
<td>● 1 piece of M5 L-shape hexagon screw driver</td>
<td></td>
</tr>
<tr>
<td>● 1 piece of Installation Guide for Stand Set</td>
<td></td>
</tr>
<tr>
<td>3. Flexible Media Support System Package</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Items</th>
<th>P-3-60</th>
<th>P-3-132S</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 set of Roll Media Flange (2 pieces)</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>1 set of Roll Holder (2 pieces)</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>1 set of Roll Holder Guide Bushes (4 pieces)</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>1 set of Roll Holder Support (2 pieces)</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>32 pieces of M6 screws</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>1 piece of M6 L-shape hexagon screw driver</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>1 piece of Roll Base</td>
<td>V</td>
<td>V</td>
</tr>
</tbody>
</table>
4. Accessories
- 1 piece of User’s Compact Disk
- 1 piece of AC power Cord
- 1 pieces of data cable (USB cable: 3m)
- 1 set of Blade Holder Assembly (Installed in tool carriage of the cutting plotter)
- 1 piece of Blade (Installed in Blade Holder)
- 1 piece of Safe Blade
- 1 piece of Cutting Pad
- 1 piece of Tweezers
- 1 piece of Promise Card

<table>
<thead>
<tr>
<th>1.3 Product Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>The following are the main features of the Puma III series cutting plotters:</td>
</tr>
<tr>
<td>- Dual-port connectivity provides you with greater flexibility</td>
</tr>
<tr>
<td>- Up to 400-gram cutting force</td>
</tr>
<tr>
<td>- Up to 600mm/per second cutting speed</td>
</tr>
<tr>
<td>- Guaranty 3-meter tracking</td>
</tr>
<tr>
<td>- User-friendly, multi-language control panel</td>
</tr>
<tr>
<td>- Enhanced Automatic-Aligning System for automatic contour cutting</td>
</tr>
</tbody>
</table>
1.4 Appearance of Puma III

1.4.1 The Front View (Figure 1-1)

- **Grid Drums**: move the media back and forth during operation.
- **Slicer Groove**: cuts off the extra media easily along this groove.
- **Control Panel**: 14 buttons and 1 LED and 1 LCM showing messages and menus.
- **Tool Carriage**: performs the cutting with the installed blade or pen with AAS module.
- **Cutting Pad**: provides the protection of blade when the blade is cutting.
- **Alignment Rulers**: media can be aligned with the clear guide line marks.
- **Platen**: provides the surface for supporting media while cutting.

*Figure 1-1*
1.4.2 The Back View (Figure 1-2)

**Pinch Rollers**
hold the media during cutting.

**Lever**
raises or lowers the pinch rollers.

Figure 1-2
1.4.3 The Whole View (Figure 1-3)

**Stand for Puma III 60 is an optional item.**
**Stand for Puma III 132S is a standard item.**

*Figure 1-3*

**Roll Holder** – holds and supplies the roll media for cutting.

**Roll Holder Guide Bushes** – serve to keep the roll media in place when media is pulled from the roll.

**Roll Holder Support** – supports roll holders.

**T-Stand** – supports the cutting plotter

**Stand Beam** – stabilizes the body.
1.4.4 The Left-hand Side (Figure 1-4)

![Image of the left-hand side of the Puma III device]

- **Power Switch**: On when switches to [I]; Off to [O]
- **Fuse**: 3 Amp.
- **AC Power Connector**

Figure 1-4

1.4.5 The Right-hand Side (Figure 1-5)

![Image of the right-hand side of the Puma III device]

- **Serial Interface Connector (RS232C)**
  used to connect the cutting plotter to a computer through a serial interface cable.

- **USB Connector**
  used to connect the cutting plotter to a computer through a USB cable.

Figure 1-5
Chapter 2 Installation

2.1 Precaution

Notice 1

- Carefully handle the cutter to prevent any injuries.
- Make sure the power switch is off before installing the cutting plotter.

Notice 2 A proper place for installation the cutting plotter

Please select a proper location that meets the following conditions.

- The machine can be approached easily from any direction.
- Keep at least 60 cm space in front and behind the machine.
- Make sure the cutter is placed on a flat, level and sturdy surface.
- The operation temperature should be between 15 and 30°C (60-86°F) in the workshop.
- Keep the relative humidity between 25% and 75% in the workshop.
- Protecting the machine from dust and air current.
- Preventing the machine from direct sunlight.

Notice 3 Connecting the Power Supply

Check the plug of the power cord to see if it matches the wall outlet. If not, please contact your dealer.

- Insert the plug (male) into a grounded power outlet.
- Insert the other end (female) of power cord into the AC connector of cutting plotter.
2.2 Stand & Flexible Media Support System

2.2.1 Stand Installation (for P3-132)
Please follow procedure below to assemble stand and media support system.

**Step 1**
Please examine supplied items in the accessory box of stand carton before you install:

Stand is a optional item for Puma III-60, Item List:
- 2 piece of T-shape stand
- 1 piece of stand beam
- 20 pieces of M6 screws
- 1 piece of M5 L-shape hexagon screw driver
- 1 piece of Installation Guide for Stand Set

**Step 2**
- Remove the plotter body and the accessories from the shipped carton.
- Place the stand beam upright on the T-stand and follow the number 1 2 to assemble.
(See Figure 2-1 & 2-2)
Step 3
Position the stand beam perpendicularly to part 1 and put the screws into the holes and tighten them as Figure 2-2. Then the complete picture of stand will be like Figure 2-1.

Step 4
Remove the cutting plotter from the carton. Position your stand under the plotter, and then insert the screws into the holes on plotter’s bottom and tighten them up as shown in Figure 2-3.

Figure 2-3
**Step 5**
Insert the roll holder support with the screws into the holes of the stand, and then tighten them up as shown in Figure 2-4. You could decide roll holder support’s position by inserting into different holes.

![Figure 2-4](image)

**Step 6**
Place two roll holders onto the roll holder support and ensure the white protrusion is wedged in the groove. (Figure 2-5)

![Figure 2-5](image)
Step 7
Lastly, the complete picture will be shown like below. (Figure 2-6)
2.3 Desktop Flexible Media Support System (For P3-60 only)

**Step 1**
Check three spacer supports on the back of the machine.

**Step 2**
Insert the left and right roll holder base into the spacer supports on the left and right side when 2 inches roll media is used.
Step 3
Press the roll holder base and the installation is complete.

Note: Insert the left roll holder base into the middle spacer support and right roll holder base into the right one when 1 inches roll media is used.
2.4 Blade Installation

**! Caution**

Do not touch the tip of the blade by your fingers.

**! Notice**

The blade is a consumable item, which will affect the cutting quality significantly. Please replace with a new blade when having the following situations:

1. The tip of blade is broken.
2. The cutting traces are not as good as they were.
3. Uncut area remains the same even the blade force has been raised significantly.

Figure 2-11 is the picture of the blade holder. Insert a blade into the bottom of the blade holder. Pushing the pin on the top of blade holder can remove the blade. Be sure to keep your fingers away from the blade tip.

![Figure 2-11](image-url)
1. Install Blade. (Figure 2-12)

![Figure 2-12](image)

2. Push the blade to the bottom of the blade holder. (Figure 2-13)

![Figure 2-13](image)

3. Adjust the blade tip to suitable length by rotating “Blade tip adjustment screw” clockwise or counterclockwise. (Figure 2-14)

![Figure 2-14](image)

**Tips:**
“The proper length” means the blade length is about 0.1mm more than film’s thickness. For example, if the thickness of film is 0.5mm, then the blade length is properly adjusted to 0.6mm and it can completely cut through the film layer without cutting through the paper backing.
4. Insert the blade holder into tool carriage. Please note the outward ring of the holder must put into the groove of carriage firmly (Figure 2-15) and lock the grip. (Figure 2-16)

![Figure 2-15](image1)

![Figure 2-16](image2)

5. Reverse steps mentioned above to remove the blade holder.
6. Press the push-pin to remove the blade from the blade holder when replacing blade. (Figure 2-17)

![Figure 2-17](image3)
2.5 Cable Connections

Puma III communicates with a computer through **USB (Universal Serial Bus)**, or **Serial port (RS-232C)**. This chapter shows you how to connect the cutting plotter to a host computer and how to set up the computer/cutting plotter interconnection.

!! **Notice:** When USB connection is enabled, serial port will be disabled automatically.

---

**2.5.1 USB Interface**

Puma III build-in USB interface is based on the Universal Serial Bus Specifications Revision 1.1. USB is not available in Windows 95, Windows NT.

- **USB driver installation**

  **Caution!!**

  ✓ If you are using Windows 8/ 7/ Vista/ XP/ 2000 as your operating system, make sure you log in using the “Administrator” account.
Use the USB One-click Installation for quick driver installation. Follow the simple steps below for driver setup.

**Step 1:**
**Connecting your GCC cutter**
1. Turn on the machine.
2. Connect the USB connector to the machine and then USB driver will installed automatically. It will take a few minutes to find the device. Please DO NOT disconnect the USB cable until the installation has completed.
3. You can double click the USB icon on the taskbar to make sure the USB device is detected.

**Step 2:** Installing the software
(1) Put the installation CD into your CD-ROM. Please make sure that the USB device is connected before you start the driver installation.

(2) Choose the model you want to install from the driver list and click on Win 8/ 7/ Vista/ XP Driver (Manual Selection) or Win 8/ 7/ Vista/ XP Driver (Automatic detection) to start installing the Driver and AAS plugin. (The Expert Pro model is used as an illustration in the following steps.)
(3) Click “Next” to start the driver installation.

(4) The installation will take a few minutes to complete and you will see a message below and click on “OK” upon completion. Enjoy your GCC cutter!

Note:
(1) If the driver is being installed for a second time, the user will be prompted as to whether a second copy of the driver installation is required.
(2) If the user selects yes, a second copy of the driver will be installed.

For users who have upgraded Adobe Illustrator or CorelDRAW, please go to the AAS Installer page in the Properties window and click Install to access the latest version of GCC AAS Plugin.

2.5.2  Driver Un-installation
You have to remove previous version driver installed on your PC system completely before you can install the latest version successfully. Please refer to below steps.

1. Right click on the printer to remove the printer from system Printer page.
2. After removing the unit, right click on any empty space on the page and select “Server Property”
3. Select “Driver” page
Select the model and click on “Remove”.

![Remove Driver And Package dialog box]

Click on “OK”

![Print Server Properties dialog box]

Click on “Yes”
The driver installed on PC is completely removed.

### 2.5.3 RS-232 Interface

- Connecting to the RS-232 (Serial) Port

1. For Personal Computer users, connect the RS-232C cable to the serial connector of the assigned serial port (COM1 or COM2) on your host computer.

2. Set up the communication parameters (Baud Rate and Data Bits/Parity) to match the setting of software package, refer to chapter 3 – “MISC” key description.

**Caution!! Please turn off the plotter before plugging the RS-232C cable.**
2.5.4 Data Transmitting
There are two options to transmit the data from the computer to the cutting plotter:

Option 1
With proper interface settings, the data can be transmitted from your application software package to the cutting plotters directly.

Option 2
Most cutting software packages are able to emulate HP-GL or HP-GL/2 commands. As long as the file is HP-GL or HP-GL/2 format, the cutting plotter can output the data precisely.

2.4.5 Printer Sever Shared Setting
In “A-PC”, set the printer driver as a shared printer, then use B-PC to connect A-PC’s printer driver via internet.
Step1.
Please set A-PC’s printer driver to shared printer. (Right-click on printer icon, choose “Printer properties”. Click “Sharing” tab then check “Share this printer”)

Step2.
Click “Advanced” tab, then choose “Print directly to the printer” option.
Step 3.
Send a job to the machine to check if A-PC is connected to the machine.

Step 4.
Activate A-PC’s Printer Driver from B-PC’s Network.

Step 5.
Right-click on printer icon, and select “Connect” to connect A-PC’s printer.
Chapter 3 The Control Panel

This chapter describes the button operations with the LCM menu flowcharts of Puma III. When the cutting plotter is ready for use as described in Chapter 1 & 2, all functions are under default parameters.

3.1 The LCD Panel

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>LCD Screen</td>
<td>To display functions and error messages.</td>
</tr>
<tr>
<td>Power LED</td>
<td>To indicate the power status (light up: power on; light off: power off)</td>
</tr>
<tr>
<td>4 Arrow Keys</td>
<td>To move position, select function, or change setting.</td>
</tr>
<tr>
<td>ENTER</td>
<td>To set item or register the immediately preceding input value.</td>
</tr>
<tr>
<td>PAUSE/RESUME</td>
<td>To temporarily halt cutting process or to continue</td>
</tr>
<tr>
<td>ON/OFF LINE</td>
<td>To switch modes, stop cutting job, or abort changes of settings.</td>
</tr>
<tr>
<td>OFFSET</td>
<td>To adjust the value of blade’s offset.</td>
</tr>
<tr>
<td>FORCE</td>
<td>To adjust the value of cutting force.</td>
</tr>
<tr>
<td>SPEED</td>
<td>To adjust the value of cutting speed and quality.</td>
</tr>
<tr>
<td>CUT TEST</td>
<td>To perform cutting tests on different media</td>
</tr>
<tr>
<td>DATA CLEAR</td>
<td>To clear up buffer memory.</td>
</tr>
<tr>
<td>TOOL SELECT</td>
<td>To select tools.</td>
</tr>
<tr>
<td>MISC</td>
<td>To set up functions.</td>
</tr>
</tbody>
</table>

Please see details in “3.4 Menu Items”
3.2 Menu in On-line Mode

Power On  Puma III in processing

- GCC Cutter
- LCM Version -

Puma III
Firmware: Copyright:

Place Media And Then Lower Down The Lever

Roll △ Edge ▼ Single ▲

Sizing Media Width Lever Up
to Abort

Sizing Media Length Lever Up
to Abort

Top menu

S--- F----- O----
L------- W-----T1M

Sending data

[PAUSE ]
Pause Setup Resume

[FORCE]
Force: 80 gf OK: ENTER ▲ ▼

[OFFSET]
Offset: 0.275 mm OK: ENTER ▲ ▼

[DATACLEAR]
Clear Data Memory N: Cancel OK: ENTER

[TOOLSELECT]
1S: 51  F: 80  O: 0.275 M OK: ENTER ▲ ▼
Set Smoothing Cut Select: ▲ ▼ OK: ENTER

Set Tangential Mode
Select: ▲ ▼ OK: ENTER

use ▲ ▼ to select; [ENTER] to enable the setting

Speed: 51 cm/s Select: ▲ ▼ OK: ENTER ▲

UP Speed: 51 cm/s Select: ▲ ▼ OK: ENTER ▲

Quality: Fine Select: ▲ ▼ OK: ENTER
3.3 Menu in Off-line Mode

Press [ON/OFF LINE] to switch to the offline mode

- **[FORCE]**
  - Force: 80 gf
  - OK: ENTER
  - 5~400 with an increment of 5(gram force)

- **[OFFSET]**
  - Offset: 0.275 mm
  - OK: ENTER
  - 0.000~1.000 with an increment of 0.025(mm)

- **[DATA CLEAR]**
  - Clear Data Memory
  - N: Cancel
  - OK: ENTER

- **[SPEED]**
  - Speed: 51 cm/s
  - OK: ENTER
  - Speed: 3~60 with an increment of 3(cm/s)

  - UP Speed: 51 cm/s
  - OK: ENTER
  - UP Speed: 3~60 with an increment of 3(cm/s)

  - Quality: Fine
  - OK: ENTER
  - Draft, Normal, Fair, Fine

- **[CUT TEST]**
  - Square Cut
  - OK: ENTER

  - Repeat AAS Job
  - Select
  - OK: ENTER

  - Repeat Last Plot
  - Select
  - OK: ENTER

  - Pattern Setting
  - Select
  - OK: ENTER

  - Ratio Setting
  - Select
  - OK: ENTER

  - Blade Length Adjust
  - Select
  - OK: ENTER

  - Pattern: Arrow
  - Change
  - OK: ENTER

  - Ratio: 100%
  - Change
  - OK: ENTER

  - Test Blade Holder
  - OK: ENTER

  - Test Blade Length
  - OK: ENTER

  - Pattern: Cross, Arrow

  - Turn CW, Turn CCW
### 3.4 Menu Items

Below describes the functions of menu items

<table>
<thead>
<tr>
<th>Menu or Key</th>
<th>Function</th>
<th>Setting</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>--- Media sizing ---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Roll</td>
<td>To measure media width.</td>
<td>Maximum Tracking 150 meters</td>
<td></td>
</tr>
<tr>
<td>Edge</td>
<td>To measure media width and pull the media back till the front paper sensor open.</td>
<td>Maximum Tracking 150 meters</td>
<td></td>
</tr>
<tr>
<td>Single</td>
<td>To measure media width and length.</td>
<td>Maximum Tracking 10 meters</td>
<td></td>
</tr>
<tr>
<td>--- POWER ---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>To indicate the power status.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| [ Arrow Keys ] | 1. To move the tool carriage position on X or Y axis.  
2. To select functions or change values of settings. | | |
| [ ENTER ] | 1. The displayed parameters will be saved automatically.  
2. To set a new origin at the present tool carriage position.  
In “offline” mode, moving the tool carriage to desired position by [Arrow Keys], then press [ENTER] key to set a new origin. While moving with the parameters of XY-axes displayed, press [MISC] key will enable fine-tune movement; press [MISC] key again to disable the function. | | |
| [ PAUSE/RESUME ] | To temporarily halt the cutting process.  
To resume the process by press [Pause/Resume] key again. | | |
| [ ONLINE/OFFLINE ] | 1. To switch between online mode and offline mode.  
2. To stop the cutting job or abort the change of setting.  
Once press this key, the cutting job will be terminated immediately and cannot be resumed. | | |
| [ OFFSET ] | To set or modify the distance between the blade tip and the center axis. | 0.000~1.000mm | 0.275mm |
| [ FORCE ] | To set or modify the value of tool force. | 5~400gram; 5 gram/per step | 80 gram |
| [ SPEED ] | To set or modify tool speed at horizontal moving. | 3~60cm/sec; 3cm/sec per step | 51cm/sec |
| Speed | | | |
| Up Speed | To set or modify tool speed at vertical moving. | 3~60cm/sec; 3cm/sec per step | 51cm/sec |
| Cutting Quality | To set or modify cutting quality.  
[Slower speeds / higher quality - Faster speeds / lower quality] | Draft, Normal, Fair, Fine | Normal |
<p>| [ CUT TEST ] | | | |</p>
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Square Cut</strong></td>
<td>To perform a cutting test at present blade position. For more information, please refer to “4.3 Adjusting the Cutting Force and Offset” to adjust blade force and cutting speed.</td>
<td></td>
</tr>
<tr>
<td><strong>Repeat AAS Job</strong></td>
<td>To repeat AAS jobs automatically without having to operate on the computer side. Please be noted that this feature is mainly applied to the Single paper mode; please ensure a new piece of material you wish to apply this feature on is loaded and the origin repositioned to the first registration mark before starting. When the first AAS job repeat completes, the user will be offered the choice of “Repeat AAS Job Again”, please press “Online/Offline” to return to the main menu.</td>
<td></td>
</tr>
<tr>
<td><strong>Repeat Last Plot</strong></td>
<td>Recut: To repeat the last job without re-sending the data. Copy: To copy the last job without re-sending the data. * 1mm gap will be auto-generated between 2 copies). * If the media length is not enough to continue, it will show below message on LCM: Out Of Space; # of Copies finished.</td>
<td>1–99; 1 per step</td>
</tr>
<tr>
<td><strong>Pattern Setting</strong></td>
<td>To provide two patterns for cut test Note: It is recommended to select “Cross” if you are working on thick pieces of materials.</td>
<td>“Arrow” and “Cross” patterns “Arrow”</td>
</tr>
<tr>
<td><strong>Ratio Setting</strong></td>
<td>To adjust the size of the pattern</td>
<td>100%, 200%, 300%, 400% 100%</td>
</tr>
<tr>
<td><strong>Blade Length Adjust</strong></td>
<td>To adjust the length of the blade Note: 1. Keep your blade length as 0 before you start adjusting. 2. Test the blade holder first and then test the blade length by pressing ENTER. 3. Keep the blade holder at the same position when you perform blade holder and blade length tests. 4. When blade holder and blade length tests are finished, the screen will show you to what degree (the unit of the value following “CW” or “CCW” is “circle”) and in which direction [CW (clockwise) or CCW (counterclockwise)] you should turn the adjustment knob. EG, Turn CW 0.5 is telling you that you should turn the knob for half a circle counterclockwisely. 5. The value on the screen will be 0.0 when the blade length is perfect and no more adjustment needs to be made. You may start cutting at this point.</td>
<td>0.00mm-5.00mm 0.00mm</td>
</tr>
<tr>
<td><strong>[ DATA CLEAR ]</strong></td>
<td>To clear up buffer memory.</td>
<td></td>
</tr>
<tr>
<td><strong>[ TOOL SELECT ]</strong></td>
<td>To save pattern(s) of cutting parameters for later use. There are 4 sets of parameters saved in the panel. Use Page Up and Page Down keys to select the set of parameters you wish to adjust, press “Enter” to confirm (the number shown on the upper left corner will change accordingly). Each set of</td>
<td>Patterns1~4 Pattern 1</td>
</tr>
</tbody>
</table>
parameters includes Speed, Force, Offset, Up Speed, Quality and Scaling though the latter three will not be displayed in this section. To adjust or check individual parameters, go back to the responding keys on the panel and press “Enter” to confirm.

<table>
<thead>
<tr>
<th>Set Smoothing Cut</th>
<th>To enable smooth-cutting function.</th>
<th>Enable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Over Cut</td>
<td>To generate an overcut to facilitate weeding.</td>
<td>0.00mm-1.00mm 0.05mm/per step 0.00mm</td>
</tr>
<tr>
<td>Set Tangential Mode</td>
<td>To enable the emulated tangential-cutting mode for thicker media types and small letter cuts. Note: while the Offset value setting at 0.000 mm, “Set Tangential Mode” will automatically be disabled.</td>
<td>Disable</td>
</tr>
<tr>
<td>Panel Setup</td>
<td>Accept setup command: To accept commands of the Force, Speed, Cutting Quality, and Offset only via software.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Control panel only: To accept commands of the Force, Speed, Cutting Quality, and Offset only via control panel of the cutter.</td>
<td></td>
</tr>
<tr>
<td>Restore Default</td>
<td>To turn all parameters of the menu items to factory-default settings.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>[ MISC ]</th>
<th></th>
<th></th>
</tr>
</thead>
</table>
| Auto Unrolled Media     | To avoid paper jam and motor crash by automatically unroll media (50cm and up) before cutting while enabled.  
* Auto-unroll only effects on roll/edge media.  
* Using Single mode to size media will disable this function automatically.  
* If the length of the rolled media is less than 2 meters or the weight is light, it is recommended to set this mode disabled. | Enable |
| Rear Paper Sensor       | To detect if the rear paper sensor is covered to determine the following process; when it is enabled, the cutter will detect if the material has covered the rear paper sensor under the Roll and Edge mode; when disabled, the rear paper sensor will not be functioning. Note: Rear paper sensor only functions under “Roll” and “Edge” mode. | Enable Disable Enable |
| Vacuum                  | To help improve tracking and cutting accuracy by turning on the fans. If you turn off the vacuum system, the fans will remain inactive during cutting or plotting. | Enable |
| First Back to Origin    | To enable the carriage back to the previous origin; when “Enable” is selected, the carriage will not go back to the previous origin while the selection of “Disable” allows the carriage to do so. | Enable Disable Enable |
| AAS Offset              | To set or modify AAS offset value. You can refer to “5.3 Printer Test” for more details. |        |
| Paper Saving Mode       | To save media by four different modes:  
1. Length expanded mode  
2. Width expanded mode  
3. Both expanded mode  
4. Both unexpanded mode | Length expande d mode |
| Set Communication       | To build up the communication between host computer and cutter.  
* Baud Rate is to determine the speed of data transmission.  
* Data Bits refers to the size of one block of data.  
* Parity is used to check if data was revived correctly or not.  
9600, n, 7, 1, p  9600pbs, 7 Bits with NO Parity  
9600, o, 7, 1, p  9600pbs, 7 Bits with ODD Parity |        |
<table>
<thead>
<tr>
<th>Firmware Version</th>
<th>To display the version number of Firmware and FPGA code.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Language</td>
<td>To select displayed languages on LCM panel in English, Spanish, Italian, Deutsch, Japanese, Portuguese, Polish, Turkish or French.</td>
</tr>
<tr>
<td>Select Units</td>
<td>Provide four-unit systems for users convenient.</td>
</tr>
<tr>
<td>Image Scale Length</td>
<td>To adjust the image scale of media length and width that may cause by the thickness of the media.</td>
</tr>
<tr>
<td></td>
<td>The Numerator is the ideal length, and the Denominator is the actual length measured from the resultant.</td>
</tr>
<tr>
<td></td>
<td>For example, cutting a line with 500.0 mm length. The procedure as follows:</td>
</tr>
<tr>
<td></td>
<td>1. Press the [LEFT ARROW] to choose the Numerator and select 500.0 mm,</td>
</tr>
<tr>
<td></td>
<td>2. Cut the length by sending a graph file,</td>
</tr>
<tr>
<td></td>
<td>3. Measure the length then use the [RIGHT ARROW] key to choose the Denominator, then</td>
</tr>
<tr>
<td></td>
<td>4. Press [UP ARROW /DOWN ARROW] to change the values of the actual length.</td>
</tr>
<tr>
<td>Scale Length</td>
<td>Fixed scaling, for maintenance only.</td>
</tr>
<tr>
<td>Scale Width</td>
<td>Fixed scaling, for maintenance only.</td>
</tr>
</tbody>
</table>

| 9600, e, 7, 1, p | 9600pbs, 7 Bits with EVEN Parity |
| 9600, n, 8, 1, p | 9600pbs, 8 Bits with NO Parity |
| 9600, o, 8, 1, p | 9600pbs, 8 Bits with ODD Parity |
| 9600, e, 8, 1, p | 9600pbs, 8 Bits with EVEN Parity |
| 19200, n, 7, 1, p | 19200pbs, 7 Bits with NO Parity |
| 19200, o, 7, 1, p | 19200pbs, 7 Bits with ODD Parity |
| 19200, e, 7, 1, p | 19200pbs, 7 Bits with EVEN Parity |
| 19200, n, 8, 1, p | 19200pbs, 8 Bits with NO Parity |
| 19200, o, 8, 1, p | 19200pbs, 8 Bits with ODD Parity |
| 19200, e, 8, 1, p | 19200pbs, 8 Bits with EVEN Parity |
4.1 Media Loading

4.1.1 Loading the Sheet Media
To load the media properly, please follow the procedures listed below:

Pull the lever upward to raise the pinch rollers. (Figure 4-1)

Load your media on the platen and slide it under the pinch rollers from either the front side or the backside. The alignment rulers on the platen extension will help you to adjust the media precisely.

**Note:**
Be sure that the media must be covered by the paper sensors on the platen when loading the media. At least one of the two paper sensors should be covered. Once the media covers the sensor, the cutting plotter will size width and length of media automatically.

Then move the pinch rollers manually to the proper position. Be sure the pinch rollers must be positioned above the grid drum. The white marks on top trail will help you position pinch rollers when media on the platen. (Figure 4-2)
Push the lever downward to lower down the pinch rollers.

Turn on the power; the machine will be initialized. Then follow the instruction of LCM to measure the size of the media.

**Note:**
Move the pinch roller by applying force at the rear portion of the pinch roller support. Do not move it by holding its front rubber roller.

**Figure 4-3 correct way to move pinch rollers**
4.1.2 Loading the Roll Media

**Step 1**
Firstly, put the roll media guide bushes on two roll holders. (Figure 4-4)

**Figure 4-4**

```
Roll holder guide bushes
```

**Step 2**

**Option A (Use the media flange)**
Insert a roll media flange at the end of each roll media and tighten the thumbscrew until the roll media is firmly gripped. (Figure 4-5)

**Figure 4-5**

```
Roll media flange
```

Then put the roll media on the roll holders. Adjust the position of the roll media ensure that the media flange is able to run in the groove of roll holder guide bushes. (Figure 4-6)

**Figure 4-6**
Option B
Insert the two roll holders into the roll media support set, and then place the roll media directly between the two roll holders. (Figure 4-7)

Step 3
Load the media on the platen. After loading the roll media, flatten the media on the platen and hold the front edge of the roll media firmly (Figure 4-8)
Step 4
Then turn the roll downward to make an equal tension across the media. (Figure 4-9)

Step 5
Move the pinch rollers to the precise location and be careful that the pinch rollers must be positioned above the grid drums.

Step 6
Push the lever downward to lower down the pinch rollers.

Step 7
Fixes roll holder guide bushes on the roll holder to secure the roll media.

Step 8
Turn on the power switch and select Roll, Edge or Single mode appropriate for one time setup, or set to Default Roll in Sizing Setting and Roll type sizing will be performed when the machine is turned on. Then the cutting plotter is ready to work.

Step 9
Unloading media: Reversing steps mentioned above to remove the media.

For the users of Puma III-60, you can also use the “Roll Base” (a standard accessory of Puma III-60) to feed a roll media. Please adjust the position of roll base to get a good cutting result. (Figure 4-10)
4.2 Tracking Performance

In order to achieve the best tracking performance for a long plot, please leave the margin of 0.5mm~25mm in the left and right edges of the media. (Figure 4-11)

![Figure 4-11]

4.3 Cutting Force and Offset Adjustment

Before sending your designs from computer to Puma III for cutting, please make “Cut Test” to adjust cutting force and offset value.

The “Cut Test” should be repeated several times until the optimum settings are achieved.

Please follow procedure below to optimum the cutting force and offset settings.

**Step1.**
After sizing the media, press [CUT TEST] button to select the “Square Cut”, and press [ENTER KEY] to confirm.

The default cutting force and offset value of the cutting test are 80gf and 0.275mm respectively.

**Step2.**
Press [ARROW KEY] to move the tool carriage to the position where you would like to cut. Then, press the [ENTER KEY] to make a “Cut Test”.

Note: At the same time, the new origin is also set at the cut test position.

**Step3.**
When the “Cut Test” is completed, a pattern appears (please refer to Figure 4-12). Peel off the pattern to see if it can be easily separated from the media base. If the output result is good, the cutting force is set appropriately. If not or it cut through the back paper of media, press [FORCE KEY] to adjust the tool force until an optimum force is obtained.
Step4.
If the pattern appears to be BB or CC layout (see Figure 4-12), press [OFFSET KEY] to adjust the offset value until AA pattern is shown.

![Diagram showing square cut with AA, BB, CC layouts and instructions for adjusting values using offset key.]

**Figure 4-12**
4.4 When Completing the Cutting Job

After completing the cutting job, raise the sheet-loading lever, and then remove the material. You can also cut off the finished job by the Safe Blade (a standard accessory) along the knife guide. (Figure 4-13)

![Figure 4-13](image)

4.5 Puma III Print Driver setting

4.5.1 Puma III Print Driver setting>Option Page

File Function:
The file function section allows users to set the parameters of Speed, Force, Offset and Quality for later use. This section is useful when performing repeated jobs on a variety of objects, allowing you to save your frequently used cutter parameters and load them in the future.

- Custom Media: This section lists the files for the parameter settings that you have recently created and worked. You can save more than 50 files to simplify your cutting job.

- Default: This section contains the reference settings that are applicable with the verified materials to achieve the best cutting results. Please note that the setting value might need to be adjusted according to different suppliers of materials.

- SAVE: This function will save current print driver parameter settings to a file under the specified location on your computer. (Saved parameter setting files will be tagged with the Puma series extension)

- LOAD: This function allows you to load previously saved print driver parameters.
• ORIGINAL: This function will load the print driver’s original factory parameter settings.

• SAVE TO DEFAULT: This function allows you to save your current print driver parameters as the default startup settings.

• DELETE: This function will delete the file you select from the Custom Media section, whereas the settings in Default section cannot be deleted. Please note the delete function only removes the list shown in Custom Media section, it does not remove the file from your hard drive, if you wish to completely remove the file from your hard disk, you will have to manually delete the file from your operating system.

Die Cut
The Die Cut function must be activated with the Kiss Cut function to avoid the falling of cut-through materials and material jam beneath the carriage. Die Cut helps you to cut through the backing of the material while Kiss Cut cuts through only the top layer but not the backing. This will leave only tiny bits of the backing attached to the top layer, creating complete individual patterns with backing sheets (see figure 1 and 2).

![Figure 1]

![Figure 2]
To activate the Die Cut function, go to “Option”, tick “Die Cut”, and enter the amount you wish for the “Length” and “Force” of both Die Cut and Kiss Cut, then click “OK” (see figure 3).

*Note: The length setting for the cutting line of Die Cut is in the range of 0-2000mm whereas that of Kiss Cut is 0-100mm.

When the job is completed and you untick the Die Cut function, you will be able to adjust the pen speed, pen force, and offset in the section on the top following normal operating procedures (see figure 4).

Note: the extension of the blade has to be set to cut through both the top layer and the backing in the very beginning. You then adjust the tool force for the best cutting performance.

Figure 3

Figure 4
### 4.6 Reference Parameter setting for different materials

The following reference parameter is used on GCC verified materials shown in the table.

<table>
<thead>
<tr>
<th>Material</th>
<th>Wall stickers</th>
<th>Magnets</th>
<th>Protective tint</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blade</td>
<td>red</td>
<td>green</td>
<td>green</td>
</tr>
<tr>
<td>Blade tip length (mm)</td>
<td>0.3</td>
<td>0.8</td>
<td>0.3</td>
</tr>
<tr>
<td>Force (g)</td>
<td>95</td>
<td>580</td>
<td>320</td>
</tr>
<tr>
<td>Speed (cm/sec)</td>
<td>72</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Offset (mm)</td>
<td>0.275</td>
<td>0.5</td>
<td>0.5</td>
</tr>
<tr>
<td>Recommend model</td>
<td>RX, Jaguar</td>
<td>RX, Jaguar</td>
<td>RX, Jaguar, Puma, Bengal, Sable, Ex Pro, Ex 24/52, Ex 24/52 LX</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Material</th>
<th>Vehicle stickers</th>
<th>Reflective film</th>
<th>Cardboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blade</td>
<td>red</td>
<td>green</td>
<td>green</td>
</tr>
<tr>
<td>Blade tip length (mm)</td>
<td>0.27</td>
<td>0.5</td>
<td>0.3</td>
</tr>
<tr>
<td>Force (g)</td>
<td>85</td>
<td>380</td>
<td>165</td>
</tr>
<tr>
<td>Speed (cm/sec)</td>
<td>60</td>
<td>3</td>
<td>30</td>
</tr>
<tr>
<td>Offset (mm)</td>
<td>0.275</td>
<td>0.5</td>
<td>0.5</td>
</tr>
<tr>
<td>Recommend model</td>
<td>RX, Jaguar, Puma, Bengal, Sable, Ex Pro, Ex 24/52, Ex 24/52 LX</td>
<td>RX, Jaguar, Puma, Bengal, Sable, Ex Pro, Ex 24/52, Ex 24/52 LX</td>
<td>RX, Jaguar, Puma, Bengal, Sable, Ex Pro, Ex 24/52, Ex 24/52 LX</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Material</th>
<th>Window tint</th>
<th>Window decoration</th>
<th>Personalized stickers</th>
<th>Rhinestone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blade</td>
<td>red</td>
<td>red</td>
<td>red</td>
<td>green</td>
</tr>
<tr>
<td>Blade tip length (mm)</td>
<td>0.09</td>
<td>0.25</td>
<td>0.28</td>
<td>0.8</td>
</tr>
<tr>
<td>Force (g)</td>
<td>70</td>
<td>95</td>
<td>105</td>
<td>190</td>
</tr>
<tr>
<td>Speed (cm/sec)</td>
<td>72</td>
<td>65</td>
<td>72</td>
<td>15</td>
</tr>
<tr>
<td>Offset (mm)</td>
<td>0.275</td>
<td>0.275</td>
<td>0.275</td>
<td>0.5</td>
</tr>
<tr>
<td>Recommend model</td>
<td>RX, Jaguar</td>
<td>RX, Jaguar</td>
<td>RX, Jaguar</td>
<td>RX, Jaguar IV, Puma III</td>
</tr>
</tbody>
</table>
Chapter 5 Automatic-Aligning System

Please note that this chapter is only an instruction to AAS II; for step-by-step instructions, please refer to the following chapters: 08_A-3 CorelDraw Plug-In, 08_A-6 GreatCut, 08_A-7 Illustrator.

5.1 Introduction

The Puma III series cutting plotters feature a standard Automatic-Aligning System (AAS II) to guarantee precise contour cutting quality by detecting the registration marks printed around the graphic.

Notice

- Avoid any kind of light source horizontally illuminating the AAS module.

- DO NOT take off the cover of AAS module while in operation.
5.2 AAS Calibrating the System

The AAS system has one calibration procedures to ensure maximum accuracy of AAS operation. To operate the AAS you need to learn about the method of media feeding firstly. (Refer to 4.1 Media Loading.)

5.2.1 Media Calibration

Media Calibration is to ensure the sensor being able to recognize the registration marks. The factory default works on a wide range of materials. However, certain types of materials may not work properly. Performing a media calibration may become necessary while working with such materials to change the sensitivity of AAS for greater reliability. Media calibration adjusts the media feeding according to media type for better accuracy during cutting.

- **When to use**
  We suggest white media for best cutting result. It is not necessary to perform media calibration every time unless the registration marks on the printed media become undetectable in AAS sensing process.

5.2.2 AAS Calibration

The first registration mark is designed to be different in order to identify the origin for AAS auto-detection. The following precaution must be aware for registration marks to be read automatically.

- Type of media
- Registration mark pattern
- Reading range required for detection the registration marks
- Position for registration marks and medium

The registration marks have to be:

- Created by cutting software like SignPal or GCC CorelDRAW plug-in
- In black color (printing quality of registration marks is essential; incorrect, misaligned colors, blurry or smeared printout might leading to inaccurate cutting result)
- Length: The length of marks
  - Range: 5mm~50mm
  - Optimized Setting: 25mm
- Thickness: The line thickness of marks
  - Range: 1mm~2mm
  - Optimized Setting: 1mm
### 5.2.3 AAS II on Puma III

There are three types of AAS II mark patterns: 4-Point Positioning, Segmental Positioning, and Multiple Copies. Note that before print out your designs by inkjet printers, the registration marks have to be created on your graphic designs by cutting software like SignPal, EasySign or GCC CorelDraw plug-in. Hand-made marks or drawings won’t be reorganized by GCC cutting plotters. For more details about registration mark setting in cutting software, please refer to ‘Appendix A-3 : CorelDraw Plug-In Instruction’, ‘Appendix A-4 : SignPal 8.5 Instruction’, ‘Appendix A-5 : EasySIGN Instruction’ and ‘Appendix A-6 : GreatCut Instruction’

1. **4-Point Positioning**
   This is the basic mark pattern that AAS II will auto detect four registration marks and contour cut images inside those marks.
   - Command: Esc.D1;(XDist);(YDist):
   - Layout: 4 L-shaped marks at the 4 corners around the design

   ![4-Point Positioning Diagram]

2. **Segmental Positioning**
   In addition to 4 original points, the intermediate registration marks are added on both X axis and Y axis to help contour cut accurately, especially for cutting large images.
   - **Command**: Esc.D2;(XDist);(YDist);(XStep);(YStep):
   - **Layout**:
     - In-between distance on X: 200~600mm, default 300mm
In-between distance on Y: 200-600mm, default 300mm

3. Multiple Copies
The function is used to duplicate images to let you cut quantities of images at a time. The AAS II sensor will automatically scan registration marks for each individual image to ensure the contour cutting precision.

- **Command:** Esc.D3;(X Copies);(Y Copies);(Space):
- **Layout:**

5.3 Printer Test

Before performing AAS contour cutting, it’s recommended to print out a test file that you can find in the enclosed Installation CD to make sure the AAS II cutting accuracy of Puma III.

There are two testing files for AASII:
1. AAS II_X_Y_Offset_Caberation_A4 .eps (A4 size)
2. AAS II_X_Y_Offset_Caberation_600_600 .eps (Default setting, it is recommended for testing)

- Print out the testing graphic. (Please use high precision printer)
Load the graphic to Puma III and sent the file to test the cutting job.
If there are any adjustments to be made, you can change the offset value by following the steps:
- Measure the offset values from the printed line and the actual cutting line.
- Enter the AAS Offset under MISC function for the values you just measured, then press Enter.
- Test the cutting again.
- AAS II offset X and Y value is defined as following:
  **Horizontal line is defined as X and vertical is defined as Y (when facing the cutting plotter)**
- When the actual cutting line and the printed line need to be changed towards the direction of origin mark, then simply add the negative value of the offset. If the direction is from the opposite of the origin mark, then enter positive values for the offset (see the following figures). This method applies to both X and Y axes.
Note:

- Before adjusting the AAS II settings, please proceed scaling for width and length.
- The blade offset value isn’t set for this test graphic, please set it according to the blade you use.
- If you have any question, please contact us or your local distributor for assistance.

5.4 Registration Mark Offset Range
Please correctly load your media (refer to the alignment ruler on the platen) to make sure the registration marks are successfully detected. Deviation exceeds the range below will lead to detection failure.

\[ L \leq S \leq \frac{L}{2} \]

Registration Mark Length range: 5 mm \(~\) 50 mm

5.5 Contour Cutting
For accurate contour cutting with AAS function, please proceed the following steps:

**Step 1** Creating Graphics

- Create the graphic that you want to print and cut in your software.

- Create a contour for cutting around the graphic.

TIPS1: Leave some space between the graphic and contour line.
TIPS2: Create the contour in a separate layer and assign a different color for it.

- Add registration marks around the graphic.

**Note:**
The Multiple Copies function is also available. It automatically copy the graphic and registration marks.

**Step 2 Placing the Registration Marks**

- The AAS Layout Instruction:

```
* Auto-detection function on the 1st mark covers the grey area
  - Suggested 30mm margin on both left and right sides of media sheet.
  - Suggested 20~30mm margin on top of media sheet, and at least 50mm margin on the bottom edge to prevent sheets dropping or any error occurred while media sizing.
```

**Step 3 Print the Graphics**

- Print the graphic and the marks with your printer
When printing on a roll media, make sure the orientation as following:

**Step 4** Load the printout onto cutter
- The Origin Mark is is different from the rest registration marks. Please make sure the media is fed with correct direction.

**Step 5** Cut the Contour
- Send out the command from software to perform the contour cutting job.

### 5.6 Tips for AAS

For getting better results of contour cutting, there are some tips below for your reference.

- Keep light sources simple and avoid illuminating from the sides of cutter.
- Before operating AAS, change the maximum paper size in Puma III driver property.
  - **STEP 1** Find the **Puma III model** in the “Printer & Fax” folder of your PC.
  - **STEP 2** Open the Properties window and select the “Paper” tab.
  - **STEP 3** Change the maximum Paper Size of X to **1200mm**.
- Adjust the cutting speed to between 300~600mm/sec.
- Avoid the registration marks locating on the tracks of pinch rollers.
- Make sure the edge of the media is not bent up when detecting registration marks.
Chapter 6 Basic Maintenance

This chapter explains the basic maintenance (i.e. cleaning the cutting plotter) required for the cutting plotter. Except for the below mentioned, all other maintenance must be performed by a qualified service technician.

6.1 Cleaning the Cutting Plotter

In order to keep the cutting plotter under good condition and best performance, you need to clean the machine properly and regularly.

Precaution in Cleaning

✧ Unplug the cutting plotter before cleaning
✧ Never use solvents, abrasive cleaners or strong detergents for cleaning. They may damage the surface of the cutting plotter and the moving parts.

Recommended Methods

✧ Gently wipe the cutting plotter surface with a lint-free cloth. If necessary, clean with a damp cloth or an alcohol-immersed cloth. Wipe with water to rinse off any residue and dry with a soft, lint-free cloth.
✧ Wipe all dust and dirt from the tool carriage rails.
✧ Use a vacuum cleaner to empty any accumulated dirt and media residue beneath the pinch roller housing.
✧ Clean the platen, paper sensors and pinch rollers with a damp cloth or an alcohol-immersed cloth, and dry with a soft, lint-free cloth.
✧ Wipe dust and dirt from the stand.
6.2 Cleaning the Grid Drum

- Turn off the cutting plotter, and move the tool carriage away from the area needed to be cleaned.
- Raise the pinch rollers and move them away from the grid drum for cleaning.
- Use a bristle brush (a toothbrush is acceptable) to remove dust from the drum surface. Rotate the drum manually while cleaning. Refer to Figure 6-1

![Figure 6-1](image)

6.3 Cleaning the Pinch Rollers

If the pinch rollers need a thorough cleaning, use a lint-free cloth or cotton swab to wipe away the accumulated dust from the rubber portion of the pinch rollers. To prevent the pinch rollers from rotating while cleaning, use finger to hold the pinch rollers not to rotate.

If needed to remove the embedded or persistent dust, use the lint-free cloth or cotton swab moistened with rubbing alcohol.

**Note:** The daily maintenance of your cutting plotter is very important. Be sure to clean up the grid drum and pinch rollers regularly for better cutting accuracy and output quality.
Chapter 7  Trouble Shooting

This chapter is to help you correct some common problems you may come across. Prior to getting into the details of this chapter, please be sure that your application environment is compatible with the cutting plotter.

Note:
Before having your cutting plotter serviced, please make sure that the malfunction is in your cutting plotter, not the result of an interface problem or a malfunction in your computer or a software problem.

Why is the cutting plotter not functioning?

Possible Causes:

7.1  Non-Operational Problems

Check the following first:

- Does the AC power cord plug in properly?
- Does the AC power cord connected to the power connector properly?
- Does the power LED still illuminate?

Solutions:

If the LCM is able to display the message, the cutting plotter should be in a normal condition. Switch off the cutting plotter and turn it on again to see if the problem still existing.

If the LCM is not able to display any message, contact the technician from your dealer.
7.2 Operational Problems

Some mechanical problems or failure during operation will cause some problems. The error messages shown on the LCM present the problem first, and followed by recommended actions. If the problem still exists after the recommended actions have been done, have your cutting plotter serviced.

- **Error, Check Media Or Drum or X Motor**
  This message indicates that there might be a problem on the X axis. Check if the drum is working well and if the media is well loaded. Correct the problem and re-power on to reboot system.

- **Error, Check Media Or Y Motor**
  This message indicates that there might be an obstruction to carriage relating to a problem on the Y axis. Correct the problem and re-power on to reboot system.

- **Error, Check Carriage Sensor or VC Motor**
  This message indicates that the blade up/down sensor malfunction. Re-power on to re-boot system. If the problem still exists, find a serviceman.

- **Graph Was Clipped. Data In Buffer**
  This message indicates that the cutting exceeds the cutting limit. Reload larger media or re-scale the plot to a smaller size; then press the key followed by the display of LCM to continue.
7.3 Cutting Plotter/Computer Communication Problems

The messages showed below present problems in relation to cutting plotter/computer communication.

**Communication Error**
Setup: **MISC. key**

- Is the connection cable connected to the cutting plotter and computer properly?
  - Yes
  - No

  - Has the interface setting been done correctly?
    - Yes
    - No

  - Try the communication between your cutting plotter and computer. If it still does not work, have your cutting plotter serviced.
  - Refer to the "**MISC**" key in Chapter 3 - Description of Operation for the port setup.

**Note:**
The computer also needs to set up compatible communication parameters to the cutting plotter set up.

**HP-GL/2 Cmd. Error**

If your cutting plotter can not recognize the HP-GL/2 or HP-GL commands, please check the HP-GL/2 or HP-GL commands applied to your cutting plotter are used properly.
7.4 Software Problems

Check the following first:

Does your software package indicate that it will work with your computer and cutting plotter?

Does your software support HP-GL and HP-GL/2 drivers?

(* check the configuration settings of your software.)

Yes  No

Does the cutting plotter interface match the requirements of your software?

Yes  No

Most well known cutting softwares in the world have drivers for our cutting plotters. If not, use software that has HP-GL and HP-GL/2 emulation supports and you can chose the following three drivers:

- A3 size: HP7475A
- A1 size: HP7580A
- A0 size: HP Draf Pro Excel or HP Draf Master

Yes  No

Does your software recommend using a different cable?

Yes  No

Refer to Chapter 2 - Connecting your cutting plotter.

Yes  No

Try using the recommended cable.

Yes  No

Does the software vendor provide a sample file?

Yes

Re-power on the cutting plotter and try to send the file again.

No

Do something about the error message display on LCM, or consult your software vendor.
7.5 Cutting Quality Problems

**Note:** The daily maintenance of your cutting plotter is very important. Be sure to clean up the grid drum and pinch rollers regularly for better cutting accuracy and output quality.

Is the blade installed correctly and the blade holder fastened securely?

Yes

Is the blade dull or chipped?

Yes

Replace with a new blade

No

Refer to Chapter 2.3 “Blade Installation”

Is tool force set up properly? (The default for tool force is 80 gf)

Yes

Is the tool offset set up properly?

Yes

Adjust the tool offset to obtain an optimum value.

No

Adjust the tool force to obtain an optimum blade force. Refer to Chapter 4.3 “Cutting Force and Offset Adjustment”

No

Is there any dirt adhered to the blade?

Yes

Remove the blade and clean it.

No

Please contact your dealer for technician support.
## Puma III Specification

<table>
<thead>
<tr>
<th>Model Name/No.</th>
<th>P3-60</th>
<th>P3-132S</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operational Method</td>
<td>Roller-Type</td>
<td></td>
</tr>
<tr>
<td>Max. Cutting Width</td>
<td>600mm (23.6in)</td>
<td>1300mm (51.18in)</td>
</tr>
<tr>
<td>Max. Cutting Length</td>
<td>50mm (1.97in)</td>
<td></td>
</tr>
<tr>
<td>Max. Media Loading Width</td>
<td>719mm (28.3in)</td>
<td>1470mm (57.87in)</td>
</tr>
<tr>
<td>Min. Media Loading Width</td>
<td>50mm (1.97in)</td>
<td></td>
</tr>
<tr>
<td>Acceptable Material Thickness</td>
<td>0.8mm (0.03 in)</td>
<td></td>
</tr>
<tr>
<td>Number of Pinch Rollers</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>Motor Drive</td>
<td>DC Servo Control</td>
<td></td>
</tr>
<tr>
<td>Cutting Force</td>
<td>400 g</td>
<td></td>
</tr>
<tr>
<td>Max. Cutting Speed</td>
<td>Up to 600 mm/sec (23.62 ips)</td>
<td></td>
</tr>
<tr>
<td>Offset</td>
<td>0~1.0 mm (with an increase of 0.025 mm)</td>
<td></td>
</tr>
<tr>
<td>Mechanical Resolution</td>
<td>0.009 mm (0.00035&quot;)</td>
<td></td>
</tr>
<tr>
<td>Software Resolution</td>
<td>0.025 mm (0.00098&quot;)</td>
<td></td>
</tr>
<tr>
<td>Distance Accuracy</td>
<td>±0.254 mm or ±0.1% of move, whichever is greater</td>
<td></td>
</tr>
<tr>
<td>Repeatability</td>
<td>±0.1mm up to 3 meters (* certified media)</td>
<td></td>
</tr>
<tr>
<td>Automatic-Aligning System</td>
<td>Completely Automatic Contour Cutting System for print to cut solution</td>
<td></td>
</tr>
<tr>
<td>Memory Buffer</td>
<td>4MB</td>
<td></td>
</tr>
<tr>
<td>Interfaces</td>
<td>USB 2.0 (Full Speed) and Serial (RS-232C)</td>
<td></td>
</tr>
<tr>
<td>Type of Command</td>
<td>HP-GL, HP-GL/2</td>
<td></td>
</tr>
<tr>
<td>Control Panel</td>
<td>LCD (20 digits x 2 lines), 14 Keys, 1 Power LED</td>
<td></td>
</tr>
<tr>
<td>Dimension (HxWxD) mm</td>
<td>220 x 879 x 258</td>
<td>1065 x 1632 x 620 (including stand)</td>
</tr>
<tr>
<td></td>
<td>8.67 x 34.61 x 10.16 in</td>
<td>41.93 x 62.25 x 24.41 in</td>
</tr>
<tr>
<td>Net Weight</td>
<td>13kg / 28.6lb</td>
<td>53 kg / 116.4 lb</td>
</tr>
<tr>
<td>Stand</td>
<td>Optional</td>
<td>Standard</td>
</tr>
<tr>
<td>Power Supply</td>
<td>AC 100-240V, 50~60 Hz (auto switching)</td>
<td></td>
</tr>
<tr>
<td>Power Consumption</td>
<td>Max. 110 watts</td>
<td></td>
</tr>
<tr>
<td>Environment Temperature</td>
<td>15℃<del>35℃ / 60°F</del>86°F (operating)</td>
<td></td>
</tr>
<tr>
<td>Environment Humidity</td>
<td>25%~75% relative humidity (operating)</td>
<td></td>
</tr>
</tbody>
</table>

- Compatible with Windows 2000/ XP/ Vista/ 7/ 8 and MAC OS X 10.4-10.7.
- The specification and data sheet may vary with different materials used. In order to obtain the best output quality, please maintain the machine regularly and properly.
- GCC reserves the right to change the specifications at any time without notice.
- The above listed specification values are effective only when operated with media certified by GCC.
## Blade Specification

<table>
<thead>
<tr>
<th>Blade Number</th>
<th>Description</th>
</tr>
</thead>
</table>
| 20200159G      | For cutting thick fluorescent and reflective vinyl. Also for cutting detailed work in standard vinyl.  
                    | The blade is 45° with **Red Cap** (5-unit package), 0.25 mm offset          |
| 265012020G     | For cutting reflective vinyl, cardboard, sandblast, flock, and stencil sharp edge.  
                    | The blade is 60° with **Green Cap**, 0.50 mm blade offset                  |
| 26500059G      | For cutting thin sandblast mask and stencil with friction feed or sprocket feed machine.  
                    | The blade is 60° with **Blue Cap**, 0.25 mm blade offset                   |
| 26500060G      | For cutting small text and fine detail. Sharp blade with smallest offset.  
                    | The blade is 0.175 mm blade offset with **Black Cap**                       |
| 265012840G     | For thin and delicate media such as window tint.                              
                    | The blade is 25° with **Yellow Cap**, 0.25 mm blade offset                  |
About the Tool

A generic term referring to the blade that cuts the sheet, the pen that does plotting, and the LED bombsight (option) used for pointing to the reference point. OFFSET is the distance that the blade tip is displaced from the centerline of the blade.

Protrusion Length of the Blade

Length of protrusion = t1 + t2/2, but for your convenience you may just make it about 0.3mm ~ 0.5mm beyond the blade holder tip.
CorelDRAW Plug-In Instruction

AASII VBA Installer is applicable for CorelDRAW Version 13, 14, 15, 16

Installation

1. Check the “AAS CorelDraw Installer” folder in Jaguar IV Installation CD, and double click the “AASIIVBAInstaller.exe” file to run the installation program.

2. Press the “Install” button to begin installing GCC AASII CorelDRAW VBA.
User Instructions

1. Run CorelDRAW to edit your graphics and select all images at once when you wish to plot.

2. Select “Tools→Visual Basic→Play”.

The Visual Basic for Applications Marcos window will pop up. Select Global Macros(GCCAASII_Draw13.gms) under the “Macros in” manual, and press “Run”.

3. Click on “Apply” and select whether you would like to add the registration marks by page size or by object.

Note: “Add Registration Mark by Object” will be the default selection if you click on the image whereas “Add Registration Mark by page size” will be the default one when the blank area on the page is clicked.

4. Now you can print out the image file with registration marks.
Add Registration Mark by page size

If you tick “Add Registration Mark by page size” as shown in the figure below and click “Apply”, your registration marks will be created automatically.

Note:
1. The length setting will be in the range of 5-25mm according to your page size.

2. Please DO NOT make any changes to the “Origin” section when you choose to add registration marks by page size as indicated below otherwise the position of the marks will be changed.

The system will create the 4 marks on the 4 corners of the page as shown in the picture below wherever you move your image.
**Workable area**

It allows users to extend the registration mark when editing graphics.

For A4 size media sheet, the workable area is 2.5mm extended from the registration mark on left and right sides and 4.5mm extended from the registration mark on top side. On the bottom side, it is suggested to leave at least 25mm margin from the edge of media sheet to prevent sheets dropping or any error occurred while media sizing.

For A3 size media sheet, the workable area is 10mm extended from the registration mark on the left side, 9mm extended from the registration mark on the right side and 11mm extended from the registration mark on top side. On the bottom side, it is suggested to leave at least 25mm margin from the edge of media sheet to prevent sheets dropping or any error occurred while media sizing.

---

**NOTE:** Select "Edge" mode when media sizing to allow the media sheet to be unrolled. If you select "Single" mode, the media sheet will not be able to be moved back and hence fail to be detected by front paper sensor.
Add Registration Mark by Object

If you tick “Add Registration Mark by Object”, you will be offered three options of registration marks as shown below.

4-Point Positioning
- Length: The length of marks
  - Range: 5mm~50mm
  - Optimized Setting: 25mm
- Thickness: The line thickness of marks
  - Range: 1mm~2mm
  - Optimized Setting: 1mm
- Margin: The distance between marks and images
  - Range: 0mm~50mm
  - Optimized Setting: 5mm

Segmental Positioning
- X Step: The distance of intermediate position on the X axis
- Y Step: The distance of intermediate position on the Y axis
  - Range: 200mm~600mm
  - Optimized Setting: Less than 500mm

Multiple Copies
- No. of X Copies: The numbers of copies on X axis
  - Range: 1~50. (The more copies you make, the more time is needed for data transmission.)
  - Numbers of X Copies * Numbers of Y Copies = The total amount of image copies
- Copies with outline: To show outlines of image graphics

Note: The values entered in the “4-Point Positioning” section (length, thickness and margin) will still be applied when you tick “Segmental Positioning” or “Multiple Copies".
4-Point Positioning

- **Length**: The length of marks
  - Range: 5mm~50mm
  - Optimized Setting: 25mm
- **Thickness**: The line thickness of marks
  - Range: 1mm~2mm
  - Optimized Setting: 1mm
- **Margin**: The distance between marks and images
  - Range: 0mm~50mm
  - Optimized Setting: 5mm

The system will create the 4 marks as shown in the picture below.
Note:
To save your materials, in addition to amending object margins, you can also adjust the length of the registration marks (5mm minimum) when you apply 4-Point Positioning (see table 1 for suggestions based on different material sizes). The smaller the size is, the smaller the distance between the object and the registration marks is (see the figures below).

<table>
<thead>
<tr>
<th>Page size (unit: mm)</th>
<th>Suggested mark length (unit: mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A6 (105 x 148)</td>
<td>5</td>
</tr>
<tr>
<td>A5 (148 x 210)</td>
<td>8</td>
</tr>
<tr>
<td>A4 (210 x 297)</td>
<td>11</td>
</tr>
<tr>
<td>A3 (297 x 420)</td>
<td>16</td>
</tr>
<tr>
<td>A2 (420 x 594)</td>
<td>23</td>
</tr>
<tr>
<td>A1 (594 x 841) and above</td>
<td>25*</td>
</tr>
</tbody>
</table>

Table 1
*25mm is the suggested value for the registration mark length

2. The size of the registration marks would affect the accuracy of registration mark detection so please make sure the amount you enter is reasonable.

3. If you change the paper size, you will have to reset the registration marks otherwise the previous setting will be applied.
Segmental Positioning

For precise cutting quality, it is suggested to select “Segmental Positioning” when you are working on an extra long or large-sized image to increase cutting accuracy.

**Segmental Positioning**
- X Step: The distance of intermediate position on the X axis
- Y Step: The distance of intermediate position on the Y axis
  - Range: 200mm~600mm
  - Optimized Setting: Less than 500mm

The system will create the as shown in the picture below
Multiple Copies

It is suggested to select “Multiple Copies” when you would like to make several copies of one image on your material to increase cutting accuracy.

- **No. of X Copies**: The numbers of copies on X axis
- **No. of Y Copies**: The numbers of copies on Y axis
  - Range: 1~50. (The more copies you make, the more time is needed for data transmission.)
  - Numbers of X Copies * Numbers of Y Copies = The total amount of image copies
- **Copies with outline**: To show outlines of image graphics

The system will create the as shown in the picture below.
Segmental Positioning will be applied to Multiple Copies when the object to be copied is of large size (with the length or width over 200mm) to increase the accuracy of registration mark detection.

Please make sure you are happy with the settings for Segmental Positioning as these will be applied to the copies created.
Contour cutting through CorelDraw

Step 1: Position the paper with registration marks printed by your printer on the GCC cutter.

Step 2: Select “Files→Print”.

Please note that if you use CorelDraw X5, you must follow the steps below. Click the “color” page and go to the “Color conversions performed by:” and then select the model name of your cutter.
Step 2: Go to the “Layout” page and select Bottom left corner at “Reposition images to”.

Step 3: Click “Print”.
You can also add a Hot Icon for the AAS II Plug-in

Step 1: Select “Tools→Customization→Commands→Macros”.

![Image of Customization window showing Commands and Appearance options]

Step 2: Choose 【GCC_CorelDraw_AASII.GCCModule.GCC_AASII】 and drag it to the “commands” bar.

Step 3: If you want to have a different icon, select “Tools→Customization→Commands→Appearance” to import a graphics for use as the icon. Choose an icon and press OK to complete this setting.
The new SignPal 10.5 Software is Windows System compatible and all versions support the AAS II contour cutting function of RX, Jaguar IV, Puma III, Expert 24 LX, and Expert 52 LX cutting plotters.

SignPal 10.5 Instruction Index:
[1] Installing the SignPal 10.5 software
[2] Set up your GCC Cutter on Production Manager
   -- SignPal AAS II Quick Start
[3] SignPal 10.5 Feature Lists

[1] Installing the SignPal 10.5 software
To install the software, you must have Administrator privileges. To use the software, you must have Administrator or Power User privileges. See your Windows user guide for more information.
1. Make sure the dongle is inserted.
2. Uninstall any previous version of the software.
3. Insert the Installation DVD.
4. Select a language and click OK.
5. Click Next.
Please note that the pictures below of SignPal 10.5 serve as illustrations in the following steps.
6. Read the Software License Agreement and select **I accept the terms of the license agreement** and click **Next** to accept.

7. If you did not have any previous versions of the software installed, skip to the next step. If you still have a previous version of the software installed, you will be prompted to overwrite the existing installation. Click **Yes** to overwrite any previous installation of the software.

8. Select the features of the software that you want to install and click **Next**:

   - Check **GCC Production Suite** to install the software.
   - Check **Samples** to install sample files.
   - Check **SafeNet Sentinel System Driver** to install the software driver for this key. If you do not use this type of key, you do not need to install this driver.
A. To change the default destination folder, click **Browse** and choose a new destination folder.

B. To check that the drive you are installing to has enough space for the installation:
   a. Click **Disk Space**.
   b. From the drop-down menu, select the drive you want to install to, and verify that it has enough space for the installation.
   c. Click **OK**. The installation drive changes to the selected drive when you click **OK**.

9. Select the Program folder where the shortcut for the software will appear. A new folder is automatically created for the product.

10. Click **Next** to install the software.
11. Once the installer is finished installing, the **Install Manager** opens. The Install Manager will automatically enable you to access the software and any optional features.

12. Click **Done**.
13. Check which icons and preferences you want to install:

- Check **Install to desktop** to install a shortcut for the software on the desktop.
- Check **Install to startup items** to install a shortcut for the software in the Startup folder of the Start menu. If this is done, each time the computer starts up, the software will automatically start up and minimize itself, displaying an icon in the system tray of the Windows system tray.
- Check **Clear Application's previous preferences** to clear the preferences or clear the check box to retain old preferences.
- Click **OK**.
14. Open SignPal 10.5v1

15. As you have not registered before, please check on the box at bottom to register a new account.

16. Input your personal information to complete the online registration.
17. If you have registered before, please enter your Registration code as below to open SignPal 10.5v1 software.
SignPal 10.5 Instruction
Note:
1. Steps 15-17 will only be compulsory for users who have never registered before.
2. You will be prompted to the demo version registration process if the version of your dongle
does not match that of the software.

Do one of the following:

- Check **Run in demo mode** to run a demo version of any available products in any
  available language.
- Ignore the password that’s shown in the box, use the **Add** button to enter any additional
  passwords in the Optional Password section to unlock optional features. If you
  purchased additional options or you are using a different dongle than the one you
  inserted when the software was run, you may enter the option passwords in this field to
  upgrade or access your software.
- Click **Done**.
[2] Set up your GCC Cutter on Production Manager

1. Open Production Manager 10.5v1
2. Choose and set up your GCC cutter.
   (Note that AAS II System only works on RX, Jaguar IV, Puma III, Expert 24 LX, and Expert 52 LX.)
3. Select **File > Print Setup** in SignPal Software.

4. Select the printer and paper size.
-- SignPal AASII Quick Start

5. Use the **Rectangle Tool** to create a rectangle.
6. Select **Effect > Contour Cut**. Then click ‘Apply’ in DesignCentral window.
7. Apply the contour cut mark of GCC AASII by selecting Effect > Contour Cut Mark.

8. Select “GCC AASII” in SignPal DesignCentral window to create the AAS II registration marks (4-Point Positioning). Set the values as 0.1cm or above and click ‘Apply’ in DesignCentral window. The value is to define the distance between registration marks and image area. If the value is less than 0.1cm, it is likely that the image will overlap the marks and result in bad cutting quality.

9. There are three types of GCC AASII registration marks: 4-Point Positioning, Segmental Positioning, and Multiple Copies. To make ‘Segmental Positioning’ marks, please select “GCC
Segmentation” in DesignCentral window and then click ‘Apply’.

10. For ‘Multiple Copies’, this function is not available in SignPal. Currently the ‘Multiple Copies’ function is only available under CorelDraw plug-in.

11. Select File > Print to print out the image.
12. Set the Scale as 100cm = 1m (100%) in Print page.

13. Load the printout vinyl on the plotter and select **File > Cut Contour** to send data. You can preview the job and change cutter’s parameter settings in ‘Properties’ tab of Cut Contour window. The Production Manager will be automatic activated to complete the job.
### [3] SignPal 10.5 Feature Lists

<table>
<thead>
<tr>
<th></th>
<th>Pro</th>
<th>Master</th>
<th>Expert</th>
<th>Apprentice</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Text</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Text tool</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Arc Text</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Path Text</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Vertical Text</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Vertical Path Text</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Kerning</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Break apart/ Join</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Load fonts on the fly</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td><strong>Drawing</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bezier</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Freehand drawing</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Zoom to cursor</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Shapes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td>-------</td>
<td>-------</td>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>Rectangle</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Oval</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Polygon</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Starburst</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fan</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Arrow</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Border tool</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Registration mark tool</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Eyedropper</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measure tool</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Path Editing</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Point Tool</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Remove point</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>add point</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>straighten path</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Round corner</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Sharpen Corner</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Optimize by Curve</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Optimize by smooth arc</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Optimize by 3point arc</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Make Arc</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Reduce Points</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Close path</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Change Start Point</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Cleaver</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Scissors</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Make right angle</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Break path</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Join paths</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Align horizontal</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Align vertical</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Align Paths</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Apply Length and Angle</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Remove tiny objects</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>---------------------</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td><strong>Working with Files</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Job Info</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Scanning</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Send email as jpg</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
</tr>
<tr>
<td>send email as pdf</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
</tr>
<tr>
<td>send email as native</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Workspaces</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Design Editor</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color mixer</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Snap</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td><strong>Arrange</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Group</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Compound</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Mask</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Lock</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Guides</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Contour Cut</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Dimension</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Convert to outlines</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>convert linked to native</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Path direction</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Order</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Align</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Distribute</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Step and Repeat</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td><strong>Effects</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Combine</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Outline</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Contour Cut</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Distort</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shadow</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Feature</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Color Trapping</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Smooth shadow</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Bitmap</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Marquee</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eraser</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pencil</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fill</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Crop</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Autotrace</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color Trace</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Color Mode</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Production</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cut/Plot</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manual Split Lines</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tile all copies</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Panel to border</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Autoweld</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto trap</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overcut</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Optimize cutting order</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
EasySIGN Instruction

The user manual of EasySIGN software is available on the EasySIGN program CD, or you can refer to the getting started manual available on the EasySIGN webpage at http://www.easysign.com/mainwebv1/DownGT.aspx.

GCC AASII Corpmark System
This application note will show you how to use the GCC AASII corpmark system. It assumes that you have installed your GCC plotter correctly, and that you are able to cut simple jobs on it. If not, please refer to the “Getting started” manual available through the menu "Help, Various, GettingStarted.pdf".

1. Make or import a design
You can either make the design in EasySIGN or import an existing design from another application. For making the design in EasySIGN refer to the "Getting Started" manual. To import a design (for example an Adobe illustrator file) into EasySIGN, use either the compatibility option, or use direct import (menu : "File, Import"). The easiest way is to use compatibility. To do this, start EasySIGN, then use the menu “File, Compatibility”, and click the software of your choice.

This software will now start, and can be used to design or open the required job. Click the icon in the system tray to easily send the file into EasySIGN.

2. Create print & cut lines.
When your design is successfully imported into EasySIGN, you should then select the line or lines that you want to cut on your plotter. After selecting them, use the command “Edit, Convert to, Line type, Print&cut line”. The lines that will be cut are now shown in a dotted red line. Copy the design as you like.
3. Enable the cropmarks.

Right-click on an empty part of the worksheet, and choose the command “Cropmark settings”.

This will show a dialog.

Please tick the box called “Show Print & cut cropmarks”.

Next, you need to make a choice which system that you want to use, there are three different systems:

<table>
<thead>
<tr>
<th>System</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GCC AASII</td>
<td>This system uses four cropmarks, and one copy. It is meant for jobs that are not very large (like 60 cm or smaller) and that are going to be printed on single sheets.</td>
</tr>
<tr>
<td>GCC AASII, Multicopy</td>
<td>Use this system when you want to cut multiple copies of a small job. This will give you very high accuracy, but the plotter will scan every copy of the job separately, which is of course slower than one big job.</td>
</tr>
<tr>
<td>GCC AASII, Multisegment</td>
<td>Use this system when the job is large. We recommend it for jobs bigger than 60 centimeter. It will place extra markers on the sheet, which will enhance the accuracy but will take extra time to scan.</td>
</tr>
</tbody>
</table>

The size of the cropmarks is fixed at 25 mm. Just click “OK” to close the dialog. If you have chosen the “Multicopy” cropmarks, there will be extra settings for horizontal copies, vertical copies etc, please ignore these for now, we will get back to them later.
4. Position the cropmark

Use the panelling tool from the left toolbox to drag the cropmarks around your job.

Make sure that the cropmarks have some white space around them, there should not be any objects inside them, to make sure they can be scanned accurately.

5. Export the job for printing

Your design is now ready for production. Click “File, Export”, and a dialog will come up that enables you to create a file. We advise you to use “EPS Encapsulated Postscript (*.EPS)” as the output format, this can be read by any RIP or other print software. Print the resulting EPS file with the software of your choice.

6. Cut the result

Place the resulting print in your plotter. Set the plotter to “offline” and use the arrow keys to position the laser within the lower right cropmark, then set the plotter to “online”.

If you have chosen the cropmarks “Multicopy”, there is one extra step: right-click the page and go to the “Cropmark settings” dialog again. In the dialog, enter the correct values for “nr. Of copies horizontal”, “Nr of copies vertical” and “Copy distance horizontal”, “copy distance vertical”, then click “OK”.

[Image of panelling tool]
In the EasySIGN software, choose “File, Plotting”. A dialog will come up that allows you to change the plotter settings.

Just make sure that the following settings are made:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alignment plotting (1)</td>
<td>Switched on</td>
</tr>
<tr>
<td>Normal line (2)</td>
<td>Switched off</td>
</tr>
<tr>
<td>Print and cut line (3)</td>
<td>Switched on</td>
</tr>
</tbody>
</table>

Then click “OK”. Your plotter will then start scanning the cropmarks, and after that the job will be cut.
The user manual of GreatCut 2 software is available on the GCC installation CD.

GCC AASII System
Below is a step-by-step instruction of using the AAS function of GreatCut 2 software through CorelDRAW and Adobe Illustrator.

Edit your image in CorelDRAW

4-Point Positioning
Step 1. Create a new file in CorelDRAW and click on the Create contour icon in the GreatCut 2 toolbar (it would appear automatically once CorelDRAW is open).
Step 2. Complete contour line settings (including contour offset value) and press Calculate to confirm.

Contour offset is the distance between the object and the contour line.

Contour lines will be added to the images.
Step 3. Press the Settings icon on the GreatCut 2 toolbar.

Step 4. Press the button on the right of Jog marks.
Step 5. Adjust the size, object margin and line thickness of your registration marks in the Setup-Jog Marks window and click OK.

4-Point Positioning

- **Size:** The length of marks
  → Range: 5mm~50mm
  → Optimized Setting: 25mm

- **Object margin:** The distance between marks and images
  → Range: 0mm~50mm
  → Optimized Setting: 5mm

- **Line thickness:** The line thickness of marks
  → Range: 1mm~2mm
  → Optimized Setting: 1mm

Step 6. Ensure the three items below are selected and click OK.
Step 7. Click the Set Jog Marks Icon in the GreatCut 2 toolbar.

The system will create the 4 marks as shown in the picture below.
Note:
1. To save your materials, in addition to amending object margins, you can also adjust the length of the registration marks (5mm minimum) when you apply the above function (see table 1 for suggestions based on different material sizes). The smaller the size is, the smaller the distance between the object and the registration marks is (see the figures below).

![Diagram showing area to be cut and registration marks]

<table>
<thead>
<tr>
<th>Page size (unit: mm)</th>
<th>Suggested mark length (unit: mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A6 (105 x 148)</td>
<td>5</td>
</tr>
<tr>
<td>A5 (148 x 210)</td>
<td>8</td>
</tr>
<tr>
<td>A4 (210 x 297)</td>
<td>11</td>
</tr>
<tr>
<td>A3 (297 x 420)</td>
<td>16</td>
</tr>
<tr>
<td>A2 (420 x 594)</td>
<td>23</td>
</tr>
<tr>
<td>A1 (594 x 841) and above</td>
<td>25*</td>
</tr>
</tbody>
</table>

Table 1
*25mm is the suggested value for the registration mark length

2. The size of the registration marks would affect the accuracy of registration mark detection so please make sure the amount you enter is reasonable.
Output

Step 1. Select both the entire object (including registration marks and the contour line) and press the Cut icon in the GreatCut 2 toolbar.

Step 2. The system will activate GreatCut2 automatically and import the registration marks and contour line to GreatCut 2.
Step 3. Select Output under File.

Step 4. Select Cut with AAS in Mode/Tool in the Output to device window.

Complete the settings of AAS Offset, Pressure, Speed, Material width and so forth.
Step 5. Click output and the object will be sent to GCC Cutting Plotter
Advanced Settings

Segmental Positioning
For precise cutting quality, it is suggested to apply “Segmental Positioning” by adjusting the x and y distance when you are working on an extra long or large-size image to increase cutting quality.

Follow the same steps in the 4-Point Positioning section to complete the contour line setting and registration mark creation procedures. Adjust the size, object margin and line thickness of your registration marks and the space between registration marks by changing X, Y distance in the Setup-Jog Marks window and click OK.

Segmental Positioning
- **Max. x Distance**: The distance of intermediate position on the X axis
  → Range: 200-500 mm
- **Max. y Distance**: The distance of intermediate position on the Y axis
  → Range: 200-500 mm

The system will create the marks as shown in the picture below.
Follow the same steps in the **Output** section to output your image to GCC Cutting Plotter.
Multiple Copies

Follow the same steps in the 4-Point Positioning section to complete the contour line setting and registration mark creation procedures.

![Setup - Jog Marks](image)

When you apply the “Multiple Copies” function, the value that has been set in this section will still be applied.

Click the Set Jog Marks Icon in the GreatCut 2 toolbar and 4 marks will be created as shown in the picture below.

![GreatCut 2 Interface](image)
Click the Multi-copy Icon in the GreatCut 2 toolbar and complete the Number in X/Y (the number of copies desired on the X/Y axis) and Distance in X/Y (distance between each copy) settings then click OK.

Note: The spacing of vertical & horizontal (Offset X & Y) should be ≥ 20mm or = 0mm; Users are advised to set the Distance in X/Y as 0 mm to remove the space between each copy to avoid the waste of materials.
The system will create several copies of the object with registration marks as shown in the picture below.

Follow the same steps in the **Output** section to output your image to GCC Cutting Plotter.
Edit your image in Adobe Illustrator

4-Point Positioning

Step 1. Create a new file in Adobe Illustrator.

Step 2. Select the image and go to Contour in GreatCu2 in File.
Step 3. Complete contour line settings (including contour offset value) and press Calculate to confirm.

Contour offset is the distance between the object and the contour line.

Contour line is now added to the object.
Step 4. Click Settings in GreatCut 2 under File.

Step 5. Press the button on the right of Jog marks.
Step 6. Adjust the size, object margin and line thickness of your registration marks and click OK.

4-Point Positioning
- **Size**: The length of marks
  → Range: 5mm~50mm
  → Optimized Setting: 25mm
- **Object margin**: The distance between marks and images
  → Range: 0mm~50mm
  → Optimized Setting: 5mm
- **Line thickness**: The line thickness of marks
  → Range: 1mm~2mm
  → Optimized Setting: 1mm

Step 7. Ensure the three items below are selected and click OK.
Step 8. Click Set Jog Marks in GreatCut2 under File.

The system will create the 4 marks as shown in the picture below.
Output

Step 1. Select both the entire object (including registration marks and the contour line) then click Cut in GreatCut2 under File.

Step 2. The system will activate GreatCut2 automatically and import the registration marks and contour line to GreatCut 2.
Step 3. Select Output under File.

Step 4. Select Cut with AAS in Mode/Tool in the Output to device window.

Contour offset is the distance between the object and the contour line.
Step 5. Click output and the object will be sent to GCC Cutting Plotter
Advanced Settings

Segmental Positioning
For precise cutting quality, it is suggested to apply “Segmental Positioning” by adjusting the x and y distance when you are working on an extra long or large-size image to increase cutting quality.

Follow the same steps in the 4-Point Positioning section to complete the contour line setting and registration mark creation procedures. Adjust the size, object margin and line thickness of your registration marks and the space between registration marks by changing X, Y distance in the Setup-Jog Marks window and click OK.

Segmental Positioning
- **Max. x Distance**: The distance of intermediate position on the X axis
  → Range: 200-500 mm
- **Max. y Distance**: The distance of intermediate position on the Y axis
  → Range: 200-500 mm
Click the Set Jog Marks Icon in the GreatCut 2 toolbar and 4 marks will be created as shown in the picture below.

Follow the same steps in the **Output** section to output your image to GCC Cutting Plotter.
Multiple Copies

Follow the same steps in the 4-Point Positioning section to complete the contour line setting and registration mark creation procedures.

Click the Set Jog Marks Icon in the GreatCut 2 toolbar and the system will create the 4 marks as shown in the picture below.

When you apply the “Multiple Copies” function, the value that has been set in this section will still be applied.
Click Multi-Copy in GreatCut2 under File.
Complete the Number in X/Y (the number of copies desired on the X/Y axis) and Distance in X/Y (distance between each copy) settings then click OK.

Note: The spacing of vertical & horizontal (Offset X & Y) should be ≥ 20mm or = 0mm; users are advised to set the Distance in X/Y as 0 mm to remove the space between each copy to avoid the waste of materials.

The system will create several copies of the object with registration marks as shown in the picture below.

Follow the same steps in the Output section to output your image to GCC Cutting Plotter.
Illustrator Plug-In Instruction

AASII VBA Installer is applicable for Illustrator Version CS4, CS5, CS6, CC.

Installation

1. Check the “AAS Illustrator Installer” folder in Puma III Installation CD, and double click the “AASIIInstaller.exe” file to run the installation program.

2. Press the “Install” button to begin installing GCC AASII Illustrator VBA.
Printer Setting

Step 1: Right click on the printer and select Properties to open the Printer Properties page.

Step 2: Go to the Advanced page and make sure the Enable advanced printing features box is unchecked.
**User Instructions**

1) Open Illustrator.

2) Edit your image and create a contour line (Note: you must have the line width set as 0.001mm).

3) Click on the image and apply the AAS function (File→Scripts→_AASII_Reg_Mark_Setting_01_03_02)
4) Select the registration marks needed

5) Three types of registration marks are introduced here: 4-Point Positioning, Segmental Positioning and Multiple Copies.

Note:
The values entered in the “4-Point Positioning” section (length, thickness and margin) will still be applied when you tick “Segmental Positioning” or “Multiple Copies”.
6) Confirm the registration marks (the 4-Point Position mark is used as an illustration in the following steps).

7) Click on the blank area on the page and then click “Document Setup”.
8) Hit “Edit Artboards”.

9) Click on “Presets → Fit Artboard to Artwork bounds”.

![Image of Illustrator Plug-In interface]
10) Please move your mouse to the tool bar on the left when step 10) is finished and then click “Selection Tool”.

11) This will take you back to the edit mode.
12) Print out the file with the contour line and the registration marks.

13) Place the printed file on the cutter, lower the pinch rollers and then position the carriage at the origin of the registration marks.

14) Send the file to the cutter.
15) Select the cutter model, position the object in the bottom left corner.

16) Your job is now completed.
Add Registration Mark by page size
If you want to create registration mark by page size, go to “Scripts” under “File” and select “_AASII_Plug_In”

Tick “Make by page size” and click “Apply” and the registration mark will be created on the 4 corners of the page automatically, sown as below.

Note:
The length setting will be in the range of 10-50mm according to your page size
Workable area
It allows users to edit and cut graphics in the area outside the registration marks when adding registration marks by page.

For A4 size media sheet, the workable area is 2.5mm extended from the registration mark on left and right sides and 4.5mm extended from the registration mark on top side. On the bottom side, it is suggested to leave at least 25mm margin from the edge of media sheet to prevent sheets dropping or any error occurred while media sizing.

For A3 size media sheet, the workable area is 10mm extended from the registration mark on the left side, 9mm extended from the registration mark on the right side and 11mm extended from the registration mark on top side. On the bottom side, it is suggested to leave at least 25mm margin from the edge of media sheet to prevent sheets dropping or any error occurred while media sizing.

NOTE: Select “Edge” mode when media sizing to allow the media sheet to be unrolled. If you select “Single” mode, the media sheet will not be able to be moved back and hence fail to be detected by front paper sensor.
Add Registration Mark by Object

If you add registration mark by Object, you will be offered three options of registration marks.

Firstly, select the graphic which you want to add registration mark on and go to “Scripts” under “File” and select “_AASII_Plug_In”.

Make sure to untick “Make by page size” and choose one of the registration mark types whichever is suitable.
Three types of registration marks

4-Point Positioning

![Image of 4-Point Positioning settings](image)

- **Length**: The length of marks
  - Range: 5mm~50mm
  - Optimized Setting: 25mm
- **Thickness**: The line thickness of marks
  - Range: 1mm~2mm
  - Optimized Setting: 1mm
- **Margin**: The distance between marks and images
  - Range: 0mm~50mm
  - Optimized Setting: 5mm

The system will create the 4 marks as shown in the picture below.
Note:
1. To save your materials, in addition to amending object margins, you can also adjust the length of the registration marks (5mm minimum) when you apply 4-Point Positioning (see table 1 for suggestions based on different material sizes). The smaller the size is, the smaller the distance between the object and the registration marks is (see the figures below).

<table>
<thead>
<tr>
<th>Page size</th>
<th>Suggested mark length</th>
</tr>
</thead>
<tbody>
<tr>
<td>A6 (105 x 148)</td>
<td>5</td>
</tr>
<tr>
<td>A5 (148 x 210)</td>
<td>8</td>
</tr>
<tr>
<td>A4 (210 x 297)</td>
<td>11</td>
</tr>
<tr>
<td>A3 (297 x 420)</td>
<td>16</td>
</tr>
<tr>
<td>A2 (420 x 594)</td>
<td>23</td>
</tr>
<tr>
<td>A1 (594 x 841) and above</td>
<td>25*</td>
</tr>
</tbody>
</table>

*25mm is the suggested value for the registration mark length

2. The size of the registration marks would affect the accuracy of registration mark detection so please make sure the amount you enter is reasonable.
For precise cutting quality, it is suggested to select “Segmental Positioning” when you are working on an extra long or large-sized image to increase cutting accuracy.

**Segmental Positioning**

- X Step: The distance of intermediate position on the X axis
- Y Step: The distance of intermediate position on the Y axis
  - Range: 200mm~600mm
  - Optimized Setting: Less than 500mm

The system will create the marks as shown in the picture below.
It is suggested to select “Multiple Copies” when you would like to make several copies of one image on your material to increase cutting accuracy.

Multiple Copies

- **No. of X Copies**: The numbers of copies on X axis
- **No. of Y Copies**: The numbers of copies on Y axis
  - Range: 1~50. (The more copies you make, the more time is needed for data transmission.)
  - Numbers of X Copies * Numbers of Y Copies = The total amount of image copies
- **Copies with outline**: To show outlines of image graphics
- **Margin**: Space between marks; must be 0 or $\geq 20$, no negative numbers allowed

The system will create the as shown in the picture below.
DirectCut Instruction

DirectCut Mac AI Plug-in is compatible with MAC OS X 10.4-10.7 (operated with Adobe Illustrator CS2-CS5).

If you want to use Adobe Illustrator CS6 on your MAC, you may need Parallels Desktop software, Window OS and Windows based Adobe Illustrator CS6 to install Windows OS in your MAC computer and run Windows based software under MAC computer.

User Instructions

Follow the simple steps below to complete your output settings:

Step 1. Run DirectCut

1) Go to File and select “Show DirectCut Tools” under “DirectCut”
You will be presented with this dialog below:

![Dialog Image]

**Step 2. Create/ import your image/ file.**

*For texts*

1) Enter your texts in Adobe Illustrator, select the letters and click [Text outline] to outline the letters.

![Illustrator Image]

A contour line will be created for your image.

![Created Image]

Note: The line width must be set as 0.001 mm
For Images

1) Open a new image on Illustrator and decide the size of your material.

2) Select the image and click [Make outline and offset] to create outlines of graphics.

Outlines will be created for your image.
3) Click on the image and apply the AAS function by clicking the [Add registration marks] command and select the registration marks needed.

The registration marks will be created as below.
Step 3. Output

1) Click on [Plotter Setup] and select the correct model in [Plotter List].

2) Tick Default Environment to create Pen No.1 in the Pen section. Double click Pen No.1 and complete your parameter settings.
3) Select the entire object and click [Plotter Output].

4) Output the object by clicking [Export] and GCC Cutting Plotter will start cutting the image.